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ВВЕДЕНИЕ

Система автоматизированного проектирования Advanced Design 
System (программный продукт фирмы Agilent Technologies) предна-
значена для разработки аналоговых и цифровых радиоэлектронных 
устройств широкого класса. Ниже приводится последовательность 
основных команд, ориентированных на сеанс работы с программным 
обеспечением данной САПР. 

1. Запустить программу Advanced Design System. Сгенериру-
ется окно главного меню. 

2. Установить режим работы системы – аналоговый, если это не-
обходимо, выполнив команду Options> Advanced Design System 
Setup>Analog Only. Выйти из программы и снова ее запустить. 

3. Создать новый проект – команда File>New Project. 
4. Присвоить имя новому проекту и открыть его. К имени авто-

матически присоединяются символы _prj. 
5. Открыть окно схемного редактора командой File>New Sche-

matic. 
6. Сформировать схемный проект. 
7. Сохранить содержимое окна схемного редактора. Файл получа-

ет расширение *.dsn и размещается в подкаталоге network. 
8. Результаты моделирования (графики, таблицы и т.п.) сохра-

нить в файле с расширением *.dds. 
Далее приводится описание лабораторных работ, ориентирован-

ных на приобретение навыков по выполнению базовых видов анализа 
электронных устройств: анализа статического режима, анализа 
частотных, переходных и спектральных характеристик.
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Лабораторная работа № 1

ИССЛЕДОВАНИЕ СТАТИЧЕСКОГО РЕЖИМА
В ЭЛЕКТРОННЫХ УСТРОЙСТВАХ

1. Цель работы

Исследование усилительного каскада в статическом режиме с помо-
щью САПР ADS.

2. Задание

2.1. Подготовить проект задания на проведение расчета рабочих точек 
активных приборов (токи и напряжения p-n переходов) предложенной 
схемы усилителя.

2.2. Провести расчет статического режима, проанализировать полу-
ченные рабочие точки усилителя, при необходимости скорректировать па-
раметры усилителя таким образом, чтобы он находился в режиме класса 
А, и повторить расчет.

2.3. Провести расчет зависимости напряжений на переходах транзи-
сторов от напряжения источника питания в диапазоне изменения от 
0,1Еном до 2Еном (Eном – заданное номинальное значение источника пи-
тания). По результатам приближенно оценить диапазон изменения напря-
жения питания, когда сохраняется работоспособность усилителя.

3. Пример выполнения задания

3.1. Чтобы подготовить задание для проведения анализа статического 
режима схемы и определить рабочие точки транзистора, необходимо:

1) Разместить в окне схемного редактора (рис. 1) контроллер 
Component Pallete List>Devices_BJT>BJTModel, в котором необходимо 
определить параметры эквивалентной схемы биполярного транзистора. 
В этом случае необходимые параметры транзистора берутся из справоч-
ника либо из табл.5. Некоторые из них приведены ниже:

а) тип проводимости транзистора (PNP);
б) коэффициент передачи по току при включении транзистора по схе-

ме общим эмиттером (Bf = 35);
в) емкость перехода база – коллектор при нулевом смещении (Cjc=60 pF);
г) емкость перехода база – эмиттер при нулевом смещении (Cje = 250 pF);
д) активное сопротивление базы (Rb = 10 Ohm).
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2) Разместить пассивные элементы с сосредоточенными параметрами 
из группы Component Pallete List> Lumped-Components, а также сам би-
полярный транзистор BJT_PNP из ранее указанной группы. Задать номи-
налы элементов можно путем их активизации и записи в поле окна “Select 
Parameter” требуемых значений (R = 0.91 MOhm, L = 88 uH, C = 22 pF). 
Разместить источники переменного и постоянного напряжения V_AC и
V_DC (10 В) из группы Sources-Freq Domain. Соединить проводниками 
размещенные компоненты с помощью команды Wire.

3) Присвоить имена тем узлам схемы, в которых необходимо опреде-
лить напряжение (мощность), используя опцию меню схемного редактора 
Insert>Component>Name Node (Wire\Pin Label).

Рис. 1. Проект усилителя, подготовленный в схемном редакторе 
системы ADS 

 

3.2. Для проведения анализа статического режима необходимо выпол-
нить следующее:

1) Выбрать компоненту Component Palette List> Simulation DC> DC
и разместить ее на схеме.

2) Выполнить команду Simulate>Simulate.
Для просмотра карты рабочих режимов (напряжений и токов) прямо в 

схемном редакторе после моделирования усилителя необходимо исполь-
зовать команду Simulation>Annotate DC Solution. На схеме сгенерируют-
ся узловые напряжения и токи.
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3.3. Определение зависимости напряжений на переходах транзисторов 

от напряжения источника питания проводится путем выполнения сле-

дующей последовательности действий:

1) Выбрать в меню схемного редактора компоненту VAR и разместить 

ее в окне редактора. В поле окна Select Parameter этого компонента ука-

зать имя переменного параметра (выбирается произвольно) и указать его 

среднее значение (VIC = 10V).

2) Активизировать компоненту источника постоянного напряжения и

присвоить изменяемому параметру вместо числового значения имя пере-

менной, указанной в блоке VAR (Vdc = VIC).

3) Выбрать компоненту Component Palette List>Simulation-

DC>PSWP, при активизации которой необходимо:

а) присвоить имя изменяемому параметру (SweepVar = VIC).

б) установить имя контроллера проводимого анализа

(SimInstanceName[1] = DC1).

Окончательный проект задания, подготовленного в схемном редакто-

ре, приведён на рис.2.

4) Для просмотра результатов анализа необходимо выполнить команду 

Window> New Data Display. Для получения значений разности напряже-

ний на переходах транзистора нужно выбрать компоненту Eqn (с помо-

щью нее можно проводить любую постпроцессорную обработку выход-

ных параметров с использованием арифметических операций и математи-

ческих функций) и сформировать уравнения для определения их значений, 

пользуясь именами узловых напряжений, проставленных в схемном ре-

дакторе. Далее, определенные выше переменные (VBC, VCE, VBE) мож-

но вывести в виде, например, графических зависимостей, как показано на 

рис.3. Загружаться они (после активизации графического или табличного 

вывода) будут с помощью команды DataSets and Equations > Equations.
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Рис. 2. Проект задания для проведения анализа статического режима 
при изменении напряжения питания 

Рис. 3. График зависимости напряжения на переходе база-эмиттер 
транзистора от напряжения питания 

4. Содержание отчета

4.1. Цель работы и задание.
4.2. Краткие теоретические сведения о методах анализа статического 

режима.
4.3. Принципиальная схема усилителя и параметры элементов.
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4.4. Результаты расчетов (проекты для каждого исследования, подго-
товленные в схемном редакторе, карта рабочих режимов, графические за-
висимости).

4.5. Выводы.

5. Контрольные вопросы и задания

5.1. Какие вы знаете методы анализа статического режима, их достоин-
ства и недостатки?

5.2. Приведите алгоритм выполнения метода Ньютона и его графиче-
скую интерпретацию.

5.3. Назовите способы решения проблемы сходимости решения при 
анализе статического режима.

5.4. Постройте математическую модель предложенной схемы на ите-
рации метода Ньютона в базисе узловых потенциалов.

5.5. Как осуществляется контроль сходимости решения в методе Нью-
тона?

5.6. Приведите схему алгоритма работы программы анализа статиче-
ского режима.

5.7. Как загружаются в матрицу проводимостей двухполюсные пас-
сивные и активные элементы схемы?

Лабораторная работа № 2

ИССЛЕДОВАНИЕ МАЛОСИГНАЛЬНЫХ ЧАСТОТНЫХ
ХАРАКТЕРИСТИК ЭЛЕКТРОННЫХ УСТРОЙСТВ

1. Цель работы

Исследование частотных характеристик усилительного каскада в ма-
лосигнальном режиме с помощью CАПР ADS.

2. Задание
2.1. Подготовить формализованное задание в схемном редакторе для 

проведения расчета амплитудно- и фазочастотных характеристик (АЧХ и 
ФЧХ соответственно) усилителя в малосигнальном режиме.
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2.2. Провести расчет АЧХ и ФЧХ усилителя и по его результатам оп-
ределить полосу пропускания усилителя и коэффициент передачи на цен-
тральной частоте. Оценить по ФЧХ пределы полосы частот, в которой она 
остается линейной. 

2.3. Путем многовариантного анализа АЧХ при значении напряжения 
источника питания, меняющегося в пределах от 0,3Еном до 1,7Еном, рас-
считать и построить зависимости коэффициента передачи на центральной 
частоте и полосы пропускания от напряжения питания.

2.4. Провести 5-7 расчетов АЧХ при различных значениях сопротив-
ления нагрузки, определив наиболее оптимальное значение с точки зрения 
максимума коэффициента передачи на центральной частоте. Построить 
семейство полученных характеристик.

3. Пример выполнения задания

3.1. Для расчета АЧХ и ФЧХ, определения полосы пропускания усили-
теля необходимо выполнить следующие действия (считаем, что принци-
пиальная схема сформирована на основании указаний предыдущей лабо-
раторной работы):

1) Выбрать контроллер частотного анализа командой Component 
Palette List> Simulation AC> AC и разместить его в окне схемного 
редактора.

2) Активизировав AC- компоненту, установить начальные и конечные 
значения частот (Start = 0.3MHz,Stop = 0.7MHz), а также закон из-
менения частоты, например, логарифмический(Sweep Type - Log).

3) К входным узлам схемы подключить источник переменного на-
пряжения V_AC, установив амплитуду, равную 1 В. Данная ком-
понента находится в группе Sources_Freq_Domain.

4) Командой Component>Name Node присвоить имя выходному узлу
(в данном случае – vout) и разместить его на схеме, указав левой 
клавишей мыши в нужный проводник. Полученный проект задания 
приведен на рис. 4.

5) Командой Simulate>Simulate запустить проект на анализ.
6) Для получения зависимостей АЧХ и ФЧХ, которые приведены на 

рис. 6, необходимо воспользоваться командой Window>New Data
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Display, после чего указать имя выходного параметра (vout) в спи-
ске выводимых величин. В качестве единиц измерения выходного 
напряжения при оценке полосы пропускания лучше всего устано-
вить децибеллы.

Рис. 4. Проект для проведения малосигнального частотного анализа 

При визуальном определении полосы пропускания можно воспользо-
ваться маркерами: для этого нужно выполнить команду Marker>New и 
поставить появившуюся метку на соответствующий график, отметив мак-
симум АЧХ и боковые значения на уровне 3 дБ (рис. 5). Перемещение 
маркера осуществляется курсорными клавишами. 

Рис. 5. Графики АЧХ и ФЧХ и применение маркеров 
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3.2. Для определения семейства зависимостей АЧХ и ФЧХ от напря-
жения питания необходимо:

1) Присвоить варьируемому параметру этого источника (Vdc) имя пе-
ременной (VIC) вместо числового номинального значения напряже-
ния питания.

2) Описать переменную VIC в блоке определения переменных и урав-
нений VAR, присвоив ей номинальное значение.

3) Разместить компоненту Component Palette List>Simulation-
AC>PSWP, установив в ней имя контроллера анализа (AC1) и имя 
варьируемого параметра (VIC). Полученный в результате выполне-
ния указанных выше действий проект задания приведен на рис. 6.

4) Запустить проект на анализ командой Simulate>Simulate.
5) Результаты анализа выводятся в графическом виде командой Win-

dow>New Data Display при обращении к выходному параметру vout
с помощью опций dB и Phase (рис.7). Идентификацию соответствия 
характеристик тому или иному значению напряжения можно легко 
осуществить с помощью маркеров.

Рис. 6. Проект задания на анализ частотных характеристик  
в режиме изменения напряжения питания 

3.3. Для определения зависимостей частотных характеристик от сопро-
тивления нагрузки необходимо обозначить имя варьируемого параметра
(в данном случае – RNG), присвоить это имя параметру R в элементе схе-
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мы R3 и определить его в качестве варьируемого в блоках VAR и PSWP
(рис. 8).

Рис.7. Семейство зависимостей АЧХ и ФЧХ от напряжения питания 

Рис. 8. Проект задания на исследование частотных характеристик 
в режиме изменения сопротивления нагрузки 
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4. Содержание отчета

4.1. Цель работы и задание.
4.2. Краткие теоретические сведения о методах анализа малосигналь-

ных режимов и модель схемы в базисе узловых потенциалов.
4.3. Принципиальная схема усилителя и параметры элементов.
4.4. Результаты анализа и расчетов по каждому пункту задания (про-

екты в схемном редакторе, АЧХ и ФЧХ, расчетные таблицы и графики).
4.5. Выводы.

5. Контрольные вопросы и задания
5.1. Как формируется математическая модель схемы в частотной точке?
5.2. Почему анализ частотных характеристик называется малосиг-

нальным?
5.3. Приведите алгоритм работы программы анализа АЧХ и ФЧХ.
5.4. Сформируйте математическую модель предложенной схемы в 

частотной точке.
5.5. Какие ключевые команды необходимо использовать при анализе 

частотных характеристик с помощью системы ADS?
5.6. Перечислите классы устройств, для которых нельзя пользоваться 

малосигнальными методами анализа и объясните, почему.
5.7. Приведите эквивалентную схему модели биполярного транзистора 

в малосигнальном режиме. 

Лабораторная работа № 3

ИССЛЕДОВАНИЕ ПЕРЕХОДНЫХ И СПЕКТРАЛЬНЫХ
ХАРАКТЕРИСТИК В ЭЛЕКТРОННЫХ УСТРОЙСТВАХ

1. Цель работы

Исследование переходного и установившегося режима работы усили-
теля и его спектральных характеристик с помощью системы ADS.

2. Задание

2.1. Подготовить задание для проведения расчета временной зависимо-
сти выходного напряжения при воздействии на входе трапецеидального
импульса амплитудой 100 мВ. По результатам анализа построить график 
переходной характеристики и определить время нарастания и спада
импульса на выходе устройства.
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2.2. Заменить источник входного напряжения на синусоидальный с 
частотой, соответствующей центральной частоте рабочей полосы, полу-
ченной при выполнении предыдущей лабораторной работы, и амплитудой 
100 мВ. Определить установившийся режим работы схемы на основании 
проверки равенства значений выходного напряжения во временных точ-
ках, отстоящих друг от друга на величину периода входного сигнала с 
точностью до 1 %. Построить график выходного сигнала в установившем-
ся режиме.

2.3. Установить директивы для проведения Фурье-анализа выходного 
отклика в установившемся режиме на частоте входного сигнала при 10-ти 
учитываемых гармониках. Определить амплитудный и фазовый спектры.

2.4. Меняя амплитуду входного источника в указанном динамическом 
диапазоне, получить результаты спектрального анализа, на основании ко-
торых построить амплитудную и фазовую характеристику устройства в 
зависимости от значения входного источника. Обязательно исследовать 
нелинейный участок этих характеристик.

3. Пример выполнения задания
3.1. Для проведения анализа переходной характеристики при воздейст-

вии на входе трапецеидального импульса необходимо:
1) Подключить на вход время-зависимый источник напряжения, опре-

делить параметры импульса. Для этого необходимо выбрать компоненту 
VPulse из группы Component Palette List> Source Time Domain и опре-
делить следующие параметры импульса: время нарастания (Rise = 1 usec),
время спада (Fall = 1 usec), длительность вершины (Width = 2 usec), пери-
од следования (Period = 0, что соответствует одиночному импульсу).

2) Выбрать контроллер анализа переходных процессов Component 
Palette List> Simulation Transient> Tran и задать временные параметры 
анализа в диалоговом окне Time setup: Start time = 0 usec (начальное вре-
мя), Stop time = 200 usec (конечное время), min time step = 0.1 usec (ми-
нимальное значение шага численного интегрирования). Полученный в ре-
зультате выполненной последовательности действий проект приведен на 
рис. 9.

3) Запуcтить задание на анализ командой Simulate>Simulate.
4) Вывести график выходного напряжения vout командой Win-

dow>New Data Display, определить время спада и нарастания визуально 
либо с помощью маркеров (рис. 10). При необходимости повторить ана-
лиз, изменив временные интервалы.
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3.2. Для определения временной зависимости выходного напряжения 
при гармоническом входном сигнале необходимо выполнить следующее:

1) Заменить импульсный источник сигнала на источник сигнала с по-
стоянной частотой, для чего нужно выбрать компоненту Component 
Palette List>Sources-Freq Domain>V_1Tone и определить ее параметры: 
амплитуду сигнала, равную 0.1 В (V=polar(0.1,0)), частоту (Freq = 457.3 kHz).

Рис.9. Проект задания для проведения анализа переходной 
характеристики в импульсном режиме входного воздействия 

Рис.10. Отклик на импульсное входное воздействие 

2) В контроллере анализа Simulation-Transient>Tran определить вре-
менные интервалы просмотра переходной характеристики (рис. 11).
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3) Запустить задание на анализ командой Simulate>Simulate.
4) Вывести график выходного сигнала vout на экран и с помощью мар-

керов либо визуально определить время, начиная с которого процессы в 
схеме можно считать стационарными, путем сравнения значений ампли-
туды сигнала в различные моменты времени (рис.12).

Рис.11. Проект задания для анализа переходного режима 
при гармоническом входном воздействии 

Рис.12. Определение установившегося режима работы 
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3.3. Для проведения спектрального анализа выходного напряжения с 
использованием преобразования Фурье выполнить следующие действия:

1) На основании результатов выполнения предыдущего пункта опреде-
лить начальное и конечное значения интервала времени, когда можно счи-
тать, что выходной сигнал находится в установившемся режиме. Причем 
этот интервал должен соответствовать значению периода гармонического 
входного сигнала.

2) В окне просмотра выходных переходных характеристик разместить 
компоненту Eqn и определить следующее уравнение spectr = 
= fs(vout,,,,,,,4us,16us). Здесь spectr – имя спектральной характеристики 
(назначается пользователем), fs-функция, реализующая проведение Фурье-
анализа, vout- обозначение выхода схемы, 4 us и 16 us – cоответственно 
начальное и конечное значения интервала Фурье-анализа (в данном случае 
это не совсем оптимальные значения, так как режим нестационарный и 
интервал не соответствует периоду входной частоты, равному (1/(457.3 
kHz)). Можно сменить интервалы, не прибегая к повторному моделирова-
нию схемы. В данном случае более правильно было записать уравнение в 
виде spectr = fs(vout,,,,,,,19us,(19us+1/(457.3e3))).

3) Вывести на экран амплитудный (опция Magnitude) и фазовый (оп-
ция Phase) спектры, обратившись к имени spectr, которое будет находить-
ся в группе выходных параметров Equations в окне Data Sets and Equa-
tions. Для оценки коэффициентов подавления гармоник сигнала рекомен-
дуется при выводе установить опцию dB. Маркером можно выделить ин-
тересующую гармонику выходного спектра (например, первую), точно 
определив ее параметры (частоту, амплитуду). Если значения частот спек-
тра не соответствуют гармоникам входной частоты, то необходимо скор-
ректировать начальное и конечное значения временного интервала, зада-
ваемого в уравнении spectr, как указывалось выше. Максимальное коли-
чество гармоник устанавливается в блоке Tran значением параметра, оп-
ределяющего допустимый размер шага численного интегрирования (Min
Time Step), обратное значение которого и будет устанавливать наивыс-
шую частоту, учитываемую при Фурье-анализе. Результаты спектрального 
анализа в децибеллах показаны на рис. 13.

3.4. Для вариационного анализа схемы усилителя в режиме изменения 
амплитуды входного сигнала и получения динамических характеристик 
необходимо выполнить следующее: 

1) Присвоить амплитуде входного сигнала имя переменной (V = VIC) и 
определить это имя в компоненте VAR.
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2) Выбрать компоненту Component Palette List>Simulation-
Transient>PRM SWP и определить в ней варьируемую переменную (VIC) 
и ее параметры (начальное и конечное значения амплитуды напряжения и 
шаг ее изменения) аналогично ранее рассмотренным примерам анализа в 
статическом и малосигнальном режимах (рис. 14).

3) Запустить задание на моделирование командой Simulate>Simulate.
4) После завершения анализа сгенерировать окно просмотра результа-

тов в графическом виде (команда Window>New Data Display). Сформиро-
вать на экране уравнение, определяющее первую гармонику спектра вы-
ходного напряжения vout1 = spectr[1] и уравнение, определяющее пере-
менную spectr (cм. п. 3.3). Причем интервал Фурье-анализа должен точно 
соответствовать периоду входного сигнала. Индекс в квадратных скобках 
означает номер гармоники спектра, которую необходимо вывести. Далее в 
списке выходных переменных блока Equations (окно Data Sets and Equa-
tions) найти имя vout1 и вывести амплитудную характеристику первой 
гармоники выходного сигнала (опция Magnitude) в режиме изменения 
амплитуды входного сигнала (рис. 15).

Рис.13. Результаты Фурье-анализа для различных временных 
интервалов 
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Рис.14. Проект задания для проведения анализа в режиме изменения 
амплитуды входного сигнала 

 

Рис. 15. Оценка динамической характеристики 
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4. Содержание отчета

4.1. Цель работы и задание.

4.2. Краткие сведения о методах анализа переходных процессов.

4.3. Варианты заданий для каждого пункта исследований в схемном 

редакторе.

4.4. Графики зависимостей, расчетные параметры, полученные на ка-

ждом этапе выполнения задания.

4.5. Выводы по каждому пункту исследований.

5. Контрольные вопросы и задания

5.1. Какие вы знаете методы численного интегрирования (ЧИ)?

5.2. Как моделируются реактивные компоненты на шаге ЧИ?

5.3. Приведите алгоритм работы программы анализа переходного ре-

жима.

5.4. Как моделируются активные приборы при анализе переходного 

режима?

5.5. В чем выражается числовая неустойчивость методов ЧИ и как с 

ней бороться?

5.6. Назовите методы спектрального анализа электронных устройств.

5.7. Приведите методику оценки установившегося режима схемы.

5.8. Назовите достоинства и недостатки методов ЧИ.

5.9. Как формируется математическая модель схемы при анализе пере-

ходного режима?

5.10. На основании каких соображений выбирается значение шага чис-

ленного интегрирования и интервал Фурье-анализа? 
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ВАРИАНТЫ АНАЛИЗИРУЕМЫХ УСТРОЙСТВ И ПАРАМЕТРОВ

1. Двухкаскадный усилитель

Рис. 16. Принципиальная схема двухкаскадного усилителя 

Таблица 1
Параметры двухкаскадного усилителя

Номер
варианта

Ri,
Ом

R1,
кОм

R2,
кОм

R5,
Ом

R6,
Ом

C2,
мкФ

1

2

3

4

5

6

7

8

500

400

500

550

700

510

470

500

2

1,5

2,2

3

3,3

2,2

4,7

1,5

10

15

8,2

10

8,2

10

15

8,2

47

47

68

51

82

47

68

51

220

270

200

220

200

220

130

200

0,33

0,5

0,33

0,47

0,1

0,33

0,25

0,5
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2. Полосовой RC-фильтр

Рис. 17. Принципиальная схема полосового RC-фильтра 

Таблица 2
Параметры полосового RC-фильтра

Но-
мер

вари-
анта

R1,
кОм

C1,
мкФ

C2,
мкФ

R3,
КОм

R4,
кОм

R5,
кОм

E,
В

Коэффициент 
усиления

транзистора

1

2

3

4

5

6

7

8

30

50

40

30

45

50

27

30

0,01

0,015

0,02

0,01

0,033

0,015

0,1

0,05

0,015

0,02

0,01

0,01

0,02

0,047

0,05

0,01

150

100

120

200

300

150

100

200

3

3,3

4,7

4,3

4

5,1

7

4

100

100

150

100

200

130

100

130

9

10

8

6

12

9

9

9

80

100

200

100

80

50

80

80
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3. Усилитель высокой частоты (УВЧ) с общей базой
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 18. Принципиальная схема УВЧ 

Таблица 3
Параметры УВЧ

Номер

вариан-

та

С1,С6,

пФ

L1,L3,

мкГн

L2,L4,

мкГн

C2,C4,

пФ

C3,C5,

пФ
Eпит,В

1

2

3

4

5

6

7

8

100

50

100

150

100

50

100

150

0,025

0,05

0,05

0,015

0,05

0,05

0,033

0,05

1,2

1

2

1,2

2

1,2

2

2

10

20

15

10

10

12

15

10

10

20

10

10

10

15

15

12

30

25

30

27

30

25

32

27



24

4. Усилитель низкой частоты (УНЧ) с общим эмиттером

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 19. Принципиальная схема УНЧ 

Таблица 4
Параметры УНЧ 

Номер
варианта

С1,
нФ

С2,
нФ

R1,
кОм

R2,
кОм

R3,
кОм Eпит,В

1

2

3

4

5

6

7

8

22

30

22

30

47

68

30

30

2,2

1,5

3

1,2

3,3

1,5

3

1,5

910

510

820

680

680

510

680

680

10

15

15

8,2

10

12

10

8,2

100

82

50

100

50

70

70

50

100

9

15

10

12

12

12

9
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Таблица 5
Параметры транзисторов

БИБЛИОГРАФИЧЕСКИЙ СПИСОК

1. Автоматизация схемотехнического проектирования / Под ред. В.Н. 
Ильина. – М.: Радио и связь, 1987. – 386 с.

2. Автоматизация проектирования радиоэлектронных средств / Под 
ред. О.В. Алексеева. – М.: Высш. шк., 2000. – 479 с.

3. Ланцов В.Н. Основы автоматизации схемотехнического проектиро-
вания / Владим. гос. техн. ун-т.- Владимир, 1996. – 88 с.

№ Марка

Прово-
ди-

мость

Коэффици-
ент передачи 

по току Bf

Eмкость 
база-

эмиттер, 
пФ

Емкость 
база-

коллек-
тор, пФ

Сопро-
тивление 
базы, Ом

1 КТ312Б NPN 55 42 14 12

2 КТ368Б NPN 146 2 3,6 200

3 КТ363Б PNP 60 3 6 150
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